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  Financial Intelligence Unit 
Executive Summary 
Student Consultant, Joshua Antonson 
Student Consultant, Laura Lodewyk 
Community Partner, Nelson Werner 

 
 

I. About the Organization 
The Financial Intelligence Unit (FIU) is a government organization that monitors all financial 
activity in Palau. They investigate the financial activity on the island in order to identify possible 
activities relating to money laundering or terrorist financial activity. They currently receive 
financial information from the three banks on the island: Bank of Guam, BankPacific, and Bank of 
Hawaii, as well as financial information from the Palauan customs department. From the three 
banks, they receive Cash Transaction Reports (CTRs) and Suspicious Transaction Reports (STRs). 
The CTRs contain all cash deposits and withdrawals of $10,000 or more and the bank managers 
generate STRs when they notice any sort of suspicious financial activity such as a series of large 
transactions or financial transactions that do not make sense for the individual or organization. 
From Customs, the FIU receives Cross Border Currency Reports (CBCRs) that informs them about 
cash in amounts greater than $10,000 that is either entering or leaving the country. These reports 
provide the basis for any investigations into money laundering or terrorist financial activity. 
 

II. Created Financial Data Collection Process and Data 
Analysis Tool 

Previously, all Cash Transaction Reports, Suspicious Transaction Reports, and Cross Border 
Currency Reports were submitted to the FIU in paper format. Having these reports in paper format 
created many issues that hindered the FIU’s ability to perform the analysis that are integral to its 
functioning. For the FIU to be effective as an entity, they needed a better system for storing their 
reports. By storing reports electronically, the FIU will be able to search and analyze data faster and 
will not be limited in terms of physical storage space. As a result, the consultants have created a 
database for the FIU to store report data. To further streamline the reporting process, the FIU 
requested that banks and other reporting institutions submit electronic reports in a format that can be 
uploaded into the database. 
The database has tables for CTRs, STRs, CBCRs, FIB information, and Cases. There are 
corresponding forms for viewing and entering data, as well as reports to more efficiently 
disseminate the data. The biggest risk to the sustainability of the project is the process by which the 
banks will electronically submit the reports. As of now, the banks are still in discussions with their 
IT vendors about modifying their report formats into a CSV file that can be easily uploaded to the 
database. Until reports are in the proper format, manually inputting data takes time away from the 
main activity of the FIU and will cost money in the form of hiring someone to input the data. 

In the future, the database can be expanded to be linked with other government databases, receive 
reports from other reporting institutions, and provide more analysis of data.  This will increase the 
FIU’s productivity and effectiveness. 
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III. Built Informational Website 

The FIU previously did not have any formal forum to explain their mission and processes to the 
public. To provide a place for such information, an informational website was created at 
palaufiu.org that will increase general knowledge of the FIU, as well as the issue of money 
laundering.  In addition, this website increases the FIU’s credibility internally with the government 
and externally with foreign FIUs by providing validation of activity and progress. Also, The FIU is 
in the process of drafting new rules and regulations. The website provides an opportunity to post 
these regulations such that they are available to everyone. 
A WordPress account and website was created with an appropriate domain name.  The website 
contains 5 pages: ‘welcome’, ‘about’, ‘statutory authority’, ‘regulations’, and ‘contact’. To ensure 
that the site is sustained, the FIU must keep the website up-to-date and pay for the WordPress 
account on a yearly basis. The biggest risk is the website becoming outdated and irrelevant. To 
prevent this, the FIU must ensure that regular updates are made to the website to include new 
information and regulations. 

 
IV. Set Up Professional and Secure Email 

Previously, the FIU had used personal email addresses for all communication, both internally and 
externally. This was problematic, since other FIU’s will not share sensitive information to a 
personal email. Often it can be beneficial to discuss persons of interest with other FIUs in the area, 
since they might have more information on the person. To help facilitate working with other FIUs, 
in addition to providing a professional means of communication, a Zoho mail account was created 
and linked to the domain purchased for the informational website. To provide further security 
measures, such as encryption, the email was linked with a local application of Microsoft Outlook. 
The bank will use the admin email account to submit encrypted CSV files.  

 

V. Recommendations 
FIU’s Departmental Internet Connection 
The consultants recommend that the FIU set up their own personal Internet connection and LAN 
(local area network). Currently, the FIU is using the WiFi Internet of the FIC. As a result, the 
current bandwidth does not meet the needs of the FIU and it is crucial to fix this issue, given the 
new electronic reporting process and increased email use. 
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Financial Intelligence Unit 
Final Consulting Report 

Student Consultant, Joshua Antonson 
Student Consultant, Laura Lodewyk 
Community Partner, Nelson Werner 

 
I. About the Organization 

Organization 
The Financial Intelligence Unit is a government organization that monitors all financial activity in 
Palau. They investigate the financial activity on the island in order to identify possible activities 
relating to money laundering or terrorist financial activity. They currently receive financial 
information from the three banks on the island: Bank of Guam, BankPacific, and Bank of Hawaii, as 
well as financial information from the Palauan customs department. From the three banks, they 
receive Cash Transaction Reports (CTRs) and Suspicious Transaction Reports (STRs). The CTRs 
report all cash deposits and withdrawals of $10,000 or more and the bank managers generate STRs 
when they notice any sort of suspicious financial activity such as a series of large transactions or 
financial transactions that do not make sense for the individual or organization. From Customs, they 
receive Cross Border Currency Reports (CBCRs) that informs them about the movement into or out 
of the country of $10,000 or more in cash. From this, they investigate potential money laundering 
and terrorist financial activity. 
 
They currently have two employees and are looking to add another employee in the near future. 
Their office is located in Koror and is shared between the Financial Intelligence Unit and the 
Financial Institutions Commission, whose mission is to establish and maintain a financial regulatory 
and supervisory system for the Republic of Palau, consistent with international standards, which 
promotes a stable banking and financial sector that facilitates economic growth and development 
within the Republic of Palau. The FIU and FIC interact with each other on a daily basis and work 
together to monitor the financial activity in Palau. The Financial Intelligence Unit was not 
previously using technology in order to help them investigative financial activity, as all of the 
reports they receive are in paper format and are stored in file cabinets. 

Facilities 
The Financial Intelligence Unit shares an office in Koror with the Financial Institutions 
Commission, which is located on the second floor of a building above a restaurant. There is a lobby 
area, where Tikei who is the secretary for the office has a desk. The FIU has one office room, which 
is where Nelson, who is the Director of the FIU, and Boboy, who works for the Attorney General’s 
Office, has desks. The office room has a very large six-person table, which is where they hold 
meetings with the banks. The office room also has a closet, which is where they currently store file 
cabinets filled with old reports and have a printer. There is adequate lighting and enough power 
outlets for five people with computers to comfortably work. The closet has a light and two outlets, 
both of which are currently being used by the printer. The office room has an air conditioning unit 
which keeps the climate of the office very controlled during the day, however, the air conditioning 
is shut off at night.  In terms of security, they lock the front door, the door at the top of the steps, 
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and the door to the FIU’s office every night around 5pm. The staffs of the FIU and the FIC are the 
only people with keys. 

Programs 
The FIU analyzes the reports they receive to investigate possible activities relating to money 
laundering or terrorist financial activity. The FIU uses computers primarily for communication 
purposes, such as email. In the past they have attempted to use Microsoft Excel to record all the 
reports they received, but since they could not use it to analyze activity related to a specific person 
or business, discontinued use.  

Staff 
The FIU currently has two employees. Nelson Werner is the Director of the Financial Intelligence 
Unit and is essentially the person who does all of the investigation into any possible money 
laundering or terrorist financial activity. He is a lawyer and the former Attorney General of Palau. 
Currently, he uses a laptop to send and receive emails and has brief experience with Microsoft 
Excel, but they don’t use Excel on a regular basis. In addition, he has an IPad, which he uses for 
personal use. Tikei is the secretary for the FIU and is responsible for setting up meetings and the 
day-to-day operation of the FIU office. She uses a computer for email and general administrative 
work. 
 
In the future, the FIU has plans to add one more employee, Boboy, to their staff. He currently works 
for the Attorney General's office. The plan is for Boboy to be the technical support for the FIU, as 
well as to transfer the old paper reports to the new electronic system. He uses a laptop to send and 
receive emails and has experience with Microsoft office products such as Word, Excel, and Access. 

Technology Infrastructure 
Hardware: 
In terms of hardware they have a lot of old computers and laptops, most of which are not being 
used. Nelson has a desktop computer running Windows 7 and a laptop, which runs Windows 8. 
Nelson’s desktop computer can no longer connect to the WiFi in the office; the consultants believe 
that the WiFi driver on the computer is broken, so he does not use the desktop computer. They have 
two ASUS laptops, which run Windows 8. Boboy uses one when he is in the office. The other 
crashes quite frequently and is not really used by anyone on a day-to-day basis. In addition, they 
have an HP ProBook 4530s PC, which runs Windows 7 Professional and a HP Pavilion dv7 
Notebook PC, which runs Windows 8. They also have a printer, which is stored in the closet in the 
office, but it is currently not connected to the new WiFi network, so it is not being used.  
Network: 
The FIC has a WiFi network that is WPA password protected. Currently, the FIU is using that 
network, as they do not have their own network. The current password is not very secure for their 
network.  
Internet Connection: 
The Internet connection on Palau is very slow. There is no fiber optic cable that runs to Palau, 
although there are plans in the future for Palau to purchase one. As a result, all Internet connection 
is via satellite. In terms of bandwidth at the FIU, the upload speed is around 0.10 Mbps and the 
download speed is around 0.10 Mbps. As a result, uploading or downloading large files takes a very 
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long time and the ability to stream multimedia content, i.e. videos, Skype, etc., is non-existent. In 
addition, large storms or bad weather shuts down the Internet connection at the FIC and the FIU, 
which is a fairly common occurrence during the rainy season in the summer.  
Software Programs: 
Each of the laptops has the Microsoft 2007 Package Suite installed, i.e. Word, Excel, Access, 
PowerPoint, etc. Also, each of the laptops has Internet Explorer, which is what is used by the staff to 
access the Internet and send emails, but two of them also have Chrome. 

Technology Management 
They currently do not have anyone responsible for managing their technology infrastructure, nor do 
they really manage their technology infrastructure. Since their only real reliance on technology, 
previously, was email, they did not need to have someone on staff that is responsible for the 
technology infrastructure at the FIU. There is a technical support person, Conrad, who is the IT guy 
for many of the government organizations in Palau. However, Conrad is very busy working across 
the other organizations and does not have time to monitor the technology infrastructure at the FIU. 
They previously did not store any critical information electronically, install or update software, or 
update virus definitions. As mentioned, they are trying to get Boboy on staff and he would be 
responsible for managing the technology infrastructure at the FIU, but his background in technology 
is limited.  

Technology Planning 
Currently, Nelson Werner does all planning and budgeting for technology.  His current vision is to 
use technology to minimize the amount of time collecting and organizing reports, so that the FIU 
can become more effective at monitoring suspicious financial activity. A few of the FIUs in the 
region collect reports electronically and store them in a database.  He wants to be able to do the 
same, which will reduce the amount of paperwork in the office, as well as facilitate the creation of a 
database. The database will allow Nelson to look at reports that fit his search criteria without having 
to physically search through multiple file cabinets. 

Internal and External Communication 
Information is shared internally through word-of-mouth and externally via mainly phone 
communication, with some email use. The paper reports are shared internally. They rarely ever need 
to share documents or files electronically between the staff at the FIU, and do not currently have the 
capacity to do so, other than via email or usb drives. Each member of the staff has a personal email 
account that they also use for communication related to the FIU. The organization does not currently 
have a website, but Nelson would like to have one created with content related to general 
information about the FIU, where he can post new regulations and rules, and have electronic 
reporting. The major difficulty related to communication is centered on the primary method of 
information being paper reports and the large number of such reports. It takes too long for Nelson to 
gather intelligence from these reports and it is hard for him to share such information.  

Information Management 
As mentioned previously, the information that is critical to the organization is the financial reports 
that they receive from the banks in Palau and from the Customs office. They receive Cash 
Transaction Reports, Suspicious Transaction Reports, and Cross Border Currency Reports. They 
receive around 1,000 CTRs and 100 STRs annually from the three banks, with most of the reports 
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coming from the Bank of Hawaii. Currently, the managers of each of the three banks print out the 
reports and then walk the reports over to the FIU’s office. The FIU then stores the paper reports in 
file cabinets located in the office. The banks currently also file the CTRs electronically with 
FinCEN, which is the Financial Crimes Enforcement Network and is a bureau of the United States 
Department of the Treasury, through an automated process. When the bank’s system recognizes a 
transaction that requires a report, it generates a report with the necessary information. The banks 
also file the STRs electronically with FinCEN, but the bank’s branch manager must fill out the 
STRs manually when they notice any sort of suspicious financial activity. Currently, information 
does not flow electronically between the staff of the FIU, but rather is spread through in-person 
conversations or meetings. If Nelson notices any suspicious financial activity, then he will call, 
email, or go in person to talk with the Attorney General’s office and other organizations in Palau. In 
the past, they did try to transfer the paper reports to an Excel spreadsheet, but this required a lot of 
work manually entering the data. In addition, they did not have the capabilities to utilize Excel other 
than basic searching for names or businesses.  
 
Currently, there are a lot of shortcomings in how they manage the financial information. As Nelson 
mentioned, all of the intelligence that they gather from the CTRs, STRs, and Cross Border Currency 
Reports is being handled solely by himself and there is no way for him to document his findings. As 
a result, it requires him to memorize and remember anything important that he finds. He manually 
has to look through all of the reports, which takes a very long time when trying to find all of the 
reports related to a certain individual. Ideally, Nelson would like to be able to look at long term 
trends in data, such as the amount of cash coming into or leaving the country in a given year, as well 
as search for specific sets of records based on last name or account number. This is not possible 
with paper reports. In addition, the current process is difficult for the banks, because they get 
audited on how consistently they give the paper reports to the FIU, and the process of in-person 
delivery is time consuming. Also, Customs is supposed to submit their forms in-person, but they 
often forget, and Nelson has to call and ask if they have any new reports. 

Business Systems 

The FIU is part of the government; so all accounting processes such as payroll, go through them. 
Nelson fills out the necessary paperwork and sends it to its proper location. They are currently in 
the process of establishing their budget for the next year, which must be approved by the House in 
Palau.  

 
II. Created Financial Data Collection Process and Data 
Analysis Tool 

Motivation 
Previously, all Cash Transaction Reports, Suspicious Transaction Reports, and Cross Border 
Currency Reports were submitted to the FIU in paper format. Having these reports in paper format 
created many issues that hindered the FIU’s ability to perform the analysis that are integral to its 
functioning. For the FIU to be effective as an entity, they needed a better system for storing their 
reports. By storing reports electronically, the FIU will not be limited in terms of physical storage 
space and will be able to search and analyze data faster. As a result, the consultants have created a 
database for the FIU to store report data. To further streamline the reporting process, the FIU 



 

Financial Intelligence Unit  Page 7 of 91 
Joshua Antonson, Student Consultant  August 7, 2015 Joshua Antonson, Student Consultant  August 7, 2015 
Laura Lodewyk, Student Consultant 
 

requested that banks and other reporting institutions submit electronic reports in a format that can be 
uploaded into the database. In addition, submitting electronic reports would remove the need for the 
in-person delivery of reports and banks would reduce the risk of being audited for late reports. 
 
Other countries of similar size and resources do not have viable solutions. Fiji and the Cook Islands 
both have database systems that they purchased from Australia, however the system is no longer 
being sold. The Marshall Islands had a database built for them by Ken O’Brien from FinCEN. He 
visited Palau once to discuss creating a database for the FIU and is interested in coming to Palau in 
the future to meet with the FIU, but does not have the time to build one. In addition, the server 
hosting the database in the Marshall Islands broke after a couple of years and they have since gone 
back to the old method of solely using paper reports.   

Outcomes 

1. Designed and Implemented Access database 
After discussions with the FIU, the functional requirements were documented (see Appendix A), 
and it was determined that there were three possible high-level approaches. The possible solutions 
were outlined in a proposal that was presented to Bank of Hawaii, BankPacific, and Bank of Guam 
(see Appendix B). As per discussions with the FIU, the consultants recommended ‘Solution 1’, a 
local Access database with report files being encrypted and uploaded by the banks to a secure 
location for the FIU to download and decrypt.  
For the locally hosted database, it was decided to use Access. The two main decision factors were 
cost and sustainability. The FIU had Access 2007 installed on each computer in the office and there 
would be no added cost for any other software or hardware. In addition, Boboy, who will be in 
charge of the database once the consultants leave, has prior experience with Access as the Attorney 
General’s office has an Access database.  

The database application contains 10 tables (see Appendix D): 
• CTRs - Stores information about Cash Transaction Reports. 

• PersonInTransaction - Stores individual information about each person related to a given CTR. 
• STRs - Stores information about Suspicious Transaction Reports. 

• FIB - Stores information about Companies. 
• CBCRs - Stores information about Cross Border Currency Reports. 

• Cases - Stores information about which CTRs, STRs, CBCRs, and Companies pertain to a 
given Case. 

• CaseAssociatedCTRs - Stores information about which CTRs are associated with which Case. 
• CaseAssociatedSTRs - Stores information about which STRs are associated with which Case. 

• CaseAssociatedCompanies - Stores information about which Companies are associated with 
which Case. 

• CaseAssociatedCBCRs - Stores information about which CBCRs are associated with which 
Case. 
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The database application contains the following forms (see Appendix E): 
• MainForm 

• CTRs 
• STRs 

• FIB 
• CBCRs 

• Cases 
The database application contains the following reports: 

• CTRs by Person – A list of all people associated with a CTR in order by a sum of all cash 
associated with that person. 

• CTRs by Month – CTRs broken down by month with sums for each month. 
• CTRs by Year  – CTRs broken down by year and transaction direction, with sums for both year 

and direction. 
• STRs by Month – STR sums per month. 

• STRs by Year – STR sums per year. 
• Year to Date – Total amount of CTR and STR cash reported in that year. 

An original prototype of the database containing only the ‘CTR’, ‘PersonInTransaction’, and ‘STR’ 
tables and related forms/queries was created and presented to Boboy. He was able to test the 
prototype and began to input old data into the database through the appropriate forms. Through this 
testing, the consultants discovered and fixed small bugs and tweaked the design of the system, as 
well as allowed Boboy to gain familiarity with the database application. 
In order to ensure the sustainability of the system once the consultants leave, Conrad, the Palauan 
government IT guy, stopped by at multiple points in the development process in order to learn about 
the system. Conrad is familiar with Access and knew of others on island that could help maintain 
the database after the consultants left.  
The Asia/Pacific Group on Money Laundering (APG) consists of many countries and some are 
similar to Palau in terms of size and development. At the 2015 APG Annual Meeting and Technical 
Assistance and Training Forum, Nelson was asked to present on the creation of the FIU’s database. 
Many countries were interested in the project and the possibility of creating their own databases. 
2. Documented and Set Up Electronic Reporting Process 

As previously mentioned, the consultants proposed an electronic reporting process in which report 
files were encrypted and uploaded by the banks to a secure location for the FIU to download and 
decrypt. To gain a better understanding of the current process of reporting CTRs and STRs, the 
consultants met with the branch Presidents of the Palauan banks, and discussed how current 
reporting is processed and how it is electronically sent to FINCen. Through further discussions with 
Bank of Hawaii, the consultants found that reports are generated automatically by the bank's 
computer system, which was created by FIS, an outside vendor. To create separate reports that fit 
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the FIU’s desired CSV format, the main branch would have to discuss it with FIS and obtain a cost 
analysis.  

Since the bank's compliance officers and lawyers would need to spend extra time verifying the 
security of a third party storage system and this process could potentially take months, they 
suggested an alternative solution of sending encrypted email using their existing encryption system. 
In order to speed up the timeline, the FIU agreed to use encrypted email. The consultants created 
public/private keys for the FIU and delivered the FIU’s public key to the banks to use to encrypt 
email communication. 

After discovering that the reports that the banks submit to the FIU were only currently available in 
PDF format, the consultants created a document detailing the preferred submission format and 
example report files, which was delivered to the banks for feedback (see Appendix C). 
It was determined that the banks would not be able to generate reports in the correct format by the 
time the consultants left. This is the biggest risk with the project because the consultants will not be 
on island when the banks eventually submit reports electronically. In addition, the banks do not yet 
have a timeline for when they will be able to submit reports electronically. In the meantime, Boboy 
is forced to input the data into the database manually. While this is tedious as a short-term solution 
(i.e. until the banks can submit reports in the correct format), as a long-term solution it creates more 
work for the FIU and added costs if they want to hire someone to help enter data. However, once 
reports are submitted in the correct format and electronically, the amount of time spent sorting and 
analyzing reports will be dramatically decreased. It will be easier for the FIU to examine long-term 
findings and will help them present this information to outside bodies interested in said findings. 
In order to help mitigate this risk, there was a trial run of submission. The consultants encrypted and 
emailed test CSV reports to Boboy. Boboy then downloaded and decrypted the CSV reports and 
imported them into the database (see Appendix K). The import routines were saved in order to 
speed up the process in the future. In addition, the consultants met with Dina who works part-time 
at the Chamber of Commerce and previously ran an I.T. consulting company in Palau. The 
consultants ensured that Dina was comfortable with the database and took part in the trial run of 
submission. Dina will potentially be the go-to contact for any future problems regarding the 
database or the electronic reporting process and will be at the FIU during the first few real 
electronic submissions by the banks. 

3. Deployed Access database 
In order to enable multiple users to use the system concurrently, the consultants set up a Windows 
Homegroup under the FIU’s network (see Appendix F). The Access database was split into front-
end copies, which were distributed to each end user’s computer, and one back-end copy, which 
resides on Boboy’s computer (see Appendix G). The back-end database file was shared to the 
Homegroup with Read/Write access. Each user’s front-end database file was linked to this back-end 
database file (see Appendix H). In addition, splitting the database helps to avoid the 2GB database 
file size limits in access (see Appendix I). 
 
In order to increase the security of the system, the back-end database file was encrypted using a 
unique password. The front-end copies were then relinked to the back-end database and each front-
end copy was encrypted using a unique password (see Appendix J). 



 

Financial Intelligence Unit  Page 10 of 91 
Joshua Antonson, Student Consultant  August 7, 2015 
Laura Lodewyk, Student Consultant 
 

 
The final version of the database was deployed to both Nelson’s and Boboy’s computers, as well as 
to a spare Windows computer in the office. Nelson and Boboy had one week to manually enter data 
and test the system before the consultants left. After some adjustment to the system, Boboy was able 
to enter 10 real reports in about 2 hours. In addition, Nelson ran each of the reports as a test of what 
real-data will generate.  As the size of the database grows, there is the potential risk of latency issues 
when Nelson uses the database. Since the back-end data resides on Boboy’s computer, the speed of 
querying and modifying the data depends on the bandwidth of the FIU’s network for other users. 
Currently, the latency when querying or modifying data on Nelson’s computer is not a large 
inconvenience. The benefit of being able to have multiple concurrent users and to not have to worry 
about keeping the back-end data up-to-date for multiple users greatly outweighs the latency issues. 
 
Before leaving, the consultants ran through backing up the database with both Tikei and Nelson. 
They determined that the FIU will set up a schedule for backing up the database either once a month 
or after one set of reports is submitted. 
 

Recommendations 
To ensure the success of the project and the most efficient use of the new database, it is important 
that banks properly reformat their reports to meet the guidelines necessary for automatic upload into 
the database.  Since the banks are still in the process of negotiating with their vendors to update to 
reports, it is important that the banks eventually do switch to the correct format.  While the solution 
of manually entering data is appropriate for short-term, if this is used indefinitely, it diminshes the 
usefulness of the new database. In addition, in order to enter in the old data the FIU will need to hire 
someone to manually enter data on an hourly wage. By setting a reasonable deadline for the banks 
to have completed the switch to electronic reports, it ensures that the process for electronic 
submission is eventually implemented. 

For future projects, there are many opportunities for growing and expanding the database. There is a 
potential to add information from other reporting institutions in the future, without the encryption 
abilities of the banks. In this case, a potential project could be creating a secure solution for other 
reporting institutions. At that time, it would also be possible to further standardize the submission 
process so that the FIU is not receiving too many emails. Since some government organizations 
have databases that the FIU would like to connect with (such as the Office of the Attorney General 
and Immigration) it also could be beneficial to either connect the databases or create processes to 
securely transfer data over to the FIU. This would help eliminate the need for the FIU to request 
data from other offices, reducing the time spent retrieving the data for both the FIU and the assisting 
office. 

As the FIU becomes more familiar with the database, there is a possibility that they would like more 
reports, queries, and analysis for their data. Future projects could provide more detailed breakdowns 
of CTRs and STRs to further assist the FIU to meet its goals. In addition, there is the potential for 
automatic pattern detection in order to help identify key entities or patterns of suspicious 
transactions. These projects are feasible for a future TCinGC team or as a remote semester-long 
project from Carnegie Mellon University.   
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III. Built Informational Website 
Motivation 

Previously, the FIU did not have a formal method to explain their mission and processes to the 
public. This lack of information means that the majority of the public is unaware of the FIU and the 
effect that money laundering has on Palau. To provide a place for such information, an 
informational website was created that will increase general knowledge about the FIU, as well as 
the issue of money laundering.  In addition, this website increases the FIU’s credibility internally 
with the government and externally with foreign FIUs by providing validation of activity and 
progress. Also, The FIU is in the process of drafting new rules and regulations. The website 
provides an opportunity to post these regulations so that they are available to everyone. 

 

Outcomes 

In addition to the domain name necessary for the website, it was determined that a website builder 
would give the FIU the ability to sustain the website on their own. To determine what solution 
would be the most cost effective, a diagram was created that compared the cost of the domain, 
hosting, and connecting with email (see Appendix L). Wordpress fit the needs of the FIU and was 
the most budget-effective solution.  The FIU selected an appropriate domain (www.palaufiu.org) 
and created a site using Wordpress. To determine what content was appropriate for the website, 
Nelson created a list of information he would like the public to have. This was then separated into 
appropriate categories. In addition, the websites of other FIU’s were examined for inspiration and 
ideas.The website created on Wordpress contains 5 pages: 
• Home: A general landing page that gives a welcome message along with a brief description of 

the mission and purpose of the FIU. 
• About: A more detailed description of the FIU, its mission, and its history. 

• Statutory Authority: contains legislation about money laundering and the FIU. 
• Regulations: this page utilizes Wordpress' ‘blogging’ functionality. As the FIU develops 

regulations they can ‘post’ them here, along with the time and date. 
• Contact: contains a form to submit a message (sent to admin@palaufiu.org) as well as other 

contact information for the FIU. 
These pages contain information about the FIU and its purpose in the community. Now, the general 
public can learn more about the FIU and corresponding regulations. This provides the FIU the 
opportunity to increase general knowledge of the FIU and money laundering within the Palauan 
community.  
While Wordpress is designed to be used by those who do not know how to program websites, it still 
requires the user to be familiar with Wordpress and the selected theme. After the website was built, 
Boboy was walked through the most common functions such as updating a page, creating a post, 
and customizing the theme. However, these actions will most likely not occur frequently. This could 
become problematic when, in the future, the FIU wishes to update or add information to the 
website, but has not done so recently. To help prevent this from occurring, documentation was 
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created (Appendix M) that details information about the site, as well as instructions on completing 
common tasks. In addition, there are plenty of resources online, such as at 
https://en.support.wordpress.com/, in case a more advanced feature is desired. Since the resources 
necessary to complete common and advanced tasks are available to the FIU, maintaining the content 
to the website should be feasible. To ensure the website stays online, the FIU simply needs to pay 
for the hosting plan once a year.  

Recommendations 
To continue to maintain the website, the FIU needs to ensure that they purchase the Wordpress 
Premium Plan once a year. Since the FIU does not have a credit card, this means that the credit card 
attached to the account needs to be kept up to date with whoever is in charge of maintaining the 
website. This will ensure that the website is always available. To keep the website up-to-date and to 
continue to update the content, it is recommended that all new regulations are posted on the 
‘Regulations’ page, and any other information is updated as needed (ex. update the phone number 
when the FIU gets a new number).  This will ensure that the website is a reliable source of 
information. In addition, it shows that the FIU is an active part of the community and generates 
increased knowledge of the FIU’s processes and actions.  

 
 

 
IV. Set Up Professional and Secure Email 

Motivation 
Previously, the FIU had used personal email addresses for all communication, both internally and 
externally. This was problematic, since other FIU’s and the banks will not disseminate sensitive 
information to a personal email. Often it can be beneficial to discuss persons of interest with other 
FIUs in the area, since they might have more information on the person. In addition, in order to 
receive sensitive financial information from the banks, the FIU needs professional and secure 
emails. 

Outcomes 
To help facilitate working with other FIUs, in addition to providing a professional means of 
communication, a Zoho mail account was created and linked to the domain purchased for the 
informational website. Zoho mail was selected because it provides 10 professional emails as part of 
their free plan, which fits the needs of the FIU. To provide further security measures, the email was 
linked with a local application of Microsoft Outlook. Outlook allows a user to send digital 
signatures and send/receive encrypted messages. To assist the FIU with setting up Outlook to allow 
encrypted messages to be sent, documentation was created that details necessary steps to configure 
Outlook appropriately (Appendix N). There is very little risk associated with sustaining the email. 
To ensure that Zoho will continue to host the domain, it is important that the FIU reads any emails 
sent by them about potential changes in pricing or plans. To ensure Outlook remains running, the 
FIU has to ensure it completes any software updates or bug fixes sent out by Microsoft.  Checks for 
these updates can be scheduled to occur automatically or after a set period of time (ex. once a week) 
under the ‘Help’ menu. 
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Recommendations 
To ensure that all contacts have the digital signatures of the FIU, it is recommended that all emails 
contain a copy of the sender's digital signature. This is easy to accomplish by editing Outlook's 
settings, instructions can be found under ‘Digitally Sign All Outgoing Messages’ in the Email 
Encryption documentation (Appendix N). 
 

V. Additional Recommendations 
FIU’s Departmental Internet Connection 

The consultants recommend that the FIU set up their own personal Internet and LAN (local area 
network). Currently, the FIU is using the WiFi Internet of the FIC. As a result, the current 
bandwidth does not meet the needs of the FIU at approximately 0.1 Mbps uploading and 0.1 Mbps 
downloading.  

Prior to the consultants arriving in Palau, Nelson would often have to wait an hour or more just to 
read his emails. In addition, the FIU often loses Internet connection when there is heavy rain or 
storms, which occurs quite frequently during the rainy season in Palau. Given the importance of 
being able to communicate with organizations within Palau and with external organizations, the 
Internet needs to be upgraded at the FIU. Since the database and encrypted email solution requires 
the FIU to receive and download emails on a fairly regular basis, the need for increased bandwidth 
is of great importance. In addition, the current deployment setup of using Windows Homegroup to 
share the database means that all the users, except Boboy, will experience latency in using the 
application.  
 
The FIU already has an access point and WiFi enabled router setup in their office. They just need to 
purchase the Internet connection from one of the vendors in Palau. Conrad’s specialty is in 
networks, so he should be able to set up the WiFi network. In addition, there is the potential to 
establish direct connections between Nelson and Boboy’s computers in the office using Ethernet 
cables. This would greatly increase the responsiveness of the application for use by Nelson.  

 
 

 
About the Consultants 
 
Joshua Antonson graduated with a Bachelor’s in Electrical and Computer Engineering with a minor in 
Computer Science from Carnegie Mellon University in spring 2015. He will be returning to Carnegie 
Mellon University in the fall to pursue a Master’s in Electrical and Computer Engineering following 
the Technology Consulting in the Global Community internship over the summer. 
 
Laura Lodewyk is a senior in Information Systems with a minor in Animation and Special 
Effects.  She will be taking part in the Technology Consulting in the Global Community internship 
over the summer and return in the fall to complete her degree at Carnegie Mellon University. 
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Appendix A. 

Functional Requirements of Solution: 
• A system by which the financial institutions can electronically file STRs (suspicious transaction 

reports) and CTRs (cash transactions reports) 
• The FIU can access and query a database to efficiently generate the information needed to 

investigate 
o Search by name (first and/or last/name of business) 
o Search by range of dates (ex. the last year, 2014, etc.) 

o Search by account number 
o All searches will return tables of the following records 

§ All CTRs that match the given search 
§ All STRs that match the given search 

§ All Cross Border Currency Reports that match the given search 
§ Any known Business Relations 

o reports on summaries for the month/quarter with totals 
• System needs to be secure to external attacks, and the financial information needs to be 

protected 
• System needs to be able to expand to add more information than just CTRs and STRs as 

required in the future  
• Potential for other reporting institutions to be added in the future 

• Ability to include information about businesses 
• Ability to delete records 
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Appendix B. 
Project Proposal 

Introduction 
Currently, all Cash Transaction Reports and Suspicious Transaction Reports are submitted to the 
Financial Intelligence Unit (FIU) in paper format. Having these reports in paper format creates many 
issues that hinder the FIU’s ability to perform the analyses that are integral to its functioning. The FIU 
would like banks and other reporting institutions to start submitting electronic reports to increase the 
efficiency and effectiveness of the FIU. In addition, submitting electronic reports would remove the 
need for the in-person delivery of paper reports and would reduce the risk of being audited for late 
reports. In order to create a solution that is the most convenient for the banks, the FIU would like to 
receive the raw report data that is already being stored by the banks and sent to Financial Crimes 
Enforcement Network. Since the banks currently file their reports electronically with FINCen from 
their branches outside of Palau (Guam, Hawaii, etc.), the uploading of files will be an easy step for the 
banks, as they already have the raw data that they send to FINCen. This can be done in multiple ways, 
which are outlined in the proposed solutions below. 
 

Proposed Solution #1: File Storage System with Local Application 
Summary 

In this solution, the banks will upload the raw report data via flat files to a secure file storage system, 
Box. The FIU will then download the files from Box. A local database application will be created on 
the FIU’s computers, which they will then import the raw data into. Once the files are downloaded, 
they will be deleted from storage in Box. The FIU can then search and analyze the financial 
information through the local database application. This process is outlined in the diagram below: 
 

 
Advantages 

There are three main benefits to this approach. The first is security, the second is maintainability, and 
the third is cost.  
 
Box encrypts files in transfer using high-grade TLS and at rest using multi-layered 256-bit AES 
encryption. They provide the choice of customer managed keys, i.e. only the banks and the FIU know 
the keys, or to have Box manage the keys themselves. Box uses both symmetric AES and asymmetric 
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RSA encryption algorithms. To share a file, a user gets the RSA public key of the user they want to 
share it with. They then encrypt the file using that public key and the AES key. When the user receives 
the file, they decrypt it using their private key and the symmetric AES key.  AES-256 symmetric-key 
encryption has been approved by the NSA for top-secret information protection and has been adopted 
as the standard by the United States Government. Box has HIPAA compliance, has SSAE 16 Type II 
report, and is Safe Harbor certified. Thus, the file storage system we will be using is highly secure for 
storing sensitive information and the uploaded files will be secure. Once the files are downloaded onto 
the FIU’s computers, the data resides solely on computers within the FIU’s office, so the data is secure 
locally. In addition, there is an added option to encrypt the files locally using BoxCryptor before 
uploading to Box using both 256-bit AES symmetric encryption, as well as public/private key 
encryption. BoxCryptor encrypts each file using a randomly generated file key for 256-bit AES 
encryption. The file key is then encrypted using the FIU’s public key, which means that only the FIU 
will be able to decrypt the file using its own private key. Utilizing both public/private key and 256-bit 
AES symmetric encryption ensures that only the banks and the FIU will have access to the files. 
 
The second advantage is maintainability and ease of use for the banks. The uploading of files by the 
banks will be very easy using the software provided by Box and there won’t be any issues related to 
bandwidth, since the files will be relatively small (under 1MB). This will dramatically cut down on the 
time spent printing out files and manually delivering them to the FIU’s office. In addition, this is the 
most sustainable and maintainable solution for the FIU to use, since they don’t need to worry about 
any hardware issues associated with running a server locally and the process of hiring IT consultants to 
fix those issues. 
 
The third advantage is cost. BoxCryptor is completely free and personal accounts on Box are free. 
There is a size limit of 250 MB for each file, but the files that the banks will be submitting will be 
around 1MB in size, so that will not be an issue. Thus, this solution will not cost the banks or the FIU 
anything in order to create the database application and electronic reporting of records.  
 
Disadvantages 
The main disadvantage with this approach is the need for the FIU to manually download the files and 
import them into their database application. However, since the size of the files will be relatively small 
(under 1MB) and the download bandwidth speeds in the FIU’s office are around 0.1 mbps, it shouldn’t 
take more than 10-30 seconds for the FIU to download the files for each bank. In addition, there will 
be no central database, meaning that each member of the FIU will need to keep their database 
application up to date by either downloading the files manually or sharing the most up to date version 
through a usb drive.  
 

Proposed Solution #2: Cloud Hosted Application 
Summary 

For a cloud hosted application, the FIU will host their website using Amazon Web Services. AWS is a 
scalable computing platform with high availability and dependability. AWS is responsible for securing 
the underlying infrastructure that supports the cloud, and the customer is responsible for securing the 
application that runs in the cloud. This underlying infrastructure includes the hardware, software, 
networking, and facilities that run AWS services. We will be using the Elastic Beanstalk service and 
Amazon Relational Database Services (RDS), within AWS.  
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To submit their data, banks will login into to the FIU’s secure web application and upload their raw 
data via a flat file. In case submitting the raw data is not possible, there also will be forms for the banks 
to manually input the data for both CTRs and STRs. The FIU will then be able to search and analyze 
the financial information and reports via a simple web interface. The process is outlined in the diagram 
below: 

Advantages 
There are two main benefits of a cloud-hosted application. The first is security and the second is 
maintainability.   
 
Amazon Web Services has achieved ISO 27001 certification and has been validated as a Level 1 
service provider under the Payment Card Industry (PCI) Data Security Standard (DSS). Amazon Web 
Services provide much more physical security for their data centers than the FIU can provide. AWS 
data centers are housed in nondescript facilities. Physical access is strictly controlled both at the 
perimeter and at building ingress points by professional security staff utilizing video surveillance, 
intrusion detection systems, and other electronic means. Authorized staff must pass two-factor 
authentication a minimum of two times to access data center floors. All physical access to data centers 
by AWS employees is logged and audited routinely. In addition, Amazon RDS encrypts databases 
using customer created keys, so the data is encrypted at rest. Amazon RDS and Elastic Beanstalk also 
have built in firewall settings to ensure access to the application and database is strictly controlled. 
 
The second advantage is maintainability. By utilizing Amazon Elastic Beanstalk and Amazon RDS we 
can take advantage of the Platform as a Service architecture. This means that Amazon takes care of the 
infrastructure and maintenance of the software required to run an application and we only need to 
worry about the application itself. The key here is that the FIU will not need to maintain a server. 
Servers are expensive, and in case of server failure, the FIU does not have the personnel with the 
experience of knowledge needed to fix a server. Cloud hosting providers ensure that your server does 
not crash and is well maintained. In addition, in case maintenance of the application is needed, hosting 
it in the cloud means that a developer will be able to easily access and update the web application 
without needing physical proximity to the server. This eliminates the travel costs of hiring a developer 
to update necessary functionality. 
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Disadvantages 
The only downside of cloud hosting is that another entity is hosting the application for you. This means 
they (theoretically) have access to all the backend information of the web app and database. However, 
there are many laws against such actions, and any sensitive data stored in the database will be 
encrypted to provide additional security.  
 

Proposed Solution #3: Locally Hosted Application 
Summary 

The FIU will host their website and database on their own server located in the FIU’s office. To submit 
their data, banks would login into the FIU’s secure web application and upload their data to the 
database. In case submitting the raw data is not possible, there will also be forms for the banks to 
manually input the data. The FIU will then be able to search and analyze the financial information and 
reports via a simple web interface. This process is presented in the diagram below: 

 
Advantages 

The advantage of a locally hosted application is that only the FIU has access to the physical location of 
the server and application.  In addition it will be fast for the FIU to use, as they won’t be dependent on 
the slow bandwidth of the Internet in Palau.  

Disadvantages 
There are two disadvantages of locally hosting an application: maintenance and security.  If you host 
an application on your own server, you must maintain the server.  The FIU would need to set up its 
own router and personal network, as it is currently using the WiFi capabilities from the FIC. The FIU 
does not have employees with the necessary qualifications to keep a server running nor a good 
environment in which to physically house the server. In addition, if the server completely dies and a 
new one needs to be bought, the FIU does not have the necessary knowledge to set up the system on a 
new server. A good example of this is the case of the FIU in the Marshall Islands. They hosted a 
database and server locally and within a few years the server broke and they didn’t have the capability 
to fix it. They have discontinued the use of electronic reporting and have switched back to handling 
everything through paper reports. In addition, any server connected to the Internet can be subject to 
Internet based attacks. The FIU can only provide a certain level of defenses, which leaves potential for 
future attackers to gain access to the system as defense and attack tactics evolve.  
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Conclusion 
The FIU would appreciate hearing any questions or concerns you have about these proposed solutions. 
Ultimately, the FIU has the final decision on what will be the best solution for them to be the most 
effective as an entity. However, since this project will have an impact on the work processes and 
relationship between the FIU and the financial institutions of Palau, an open dialog will ensure that 
both parties can painlessly transition to an electronic reporting system.  At present, the solution that the 
FIU is advocating for is the use of a File Storage System with a local database application (#1). This 
would be the most sustainable solution, since it does not require the FIU to maintain hardware, and the 
software for uploading and downloading files would be updated by Box. In addition, it is the strongest 
option for security. Box provides security and encryption for files and the solution would not leave old 
data at rest in the Internet. Through utilizing BoxCryptor, we can ensure that only the FIU and the 
banks will have secure access to the files. Finally, when comparing the costs of each of the three 
solutions, it is clear that approach #1 is the best. A more in depth look at the advantages and 
disadvantages of the proposed solutions can be found in the following decision matrix. 
 

Decision Matrix: 
Key: 
Good Neutral Bad 
 
 

#1: File Upload w/ Local 
Application 

#2: Cloud Hosted 
Application 

#3: Locally Hosted 
Application 

Cost 
   

Solution --- ~$150-$200/year $500-$800 
every 5 years 

SSL --- $50-$100/year $50-$100/year 

Domain Name ~$12/year ~$12/year ~$12/year 

Website Hosting $60/year --- --- 

Security 
   

Physical Physical security, strict 
access policies and secure 
vaults and cages. Box has 
been issued an SSAE 16 
Type II report and is Safe 
Harbor certified. 

Security of Host 
Provider. 
onsite security 24/7, 
multiple 
authentication points, 
security cameras. 
Climate controlled, 
state-of-the-art 
facilities. 

FIU’s security. 
Potential for 
environmental 
damage 
(overheating, water 
damage, power 
surges etc) 
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Online Encryption in transfer with 
high-grade TLS and multi-
layered encryption at rest 
with 256-bit AES 

Built in firewalls, 
protected servers. 
Encryption at rest 
with 256-bit AES and 
customer held keys. 

Dependent on server 
and application 
security 

Maintainability 
   

Software Minimal maintenance 
necessary, stable software 

Hard to find support 
Can be accessed 
remotely 

Hard to find support 

Hardware --- Maintained by data 
center 

Server’s lifespan ~3-
5 years 

Scalability 
   

Size limitations of Microsoft 
Access 

You pay for what you 
use 

Limitations of the 
server 

New Report 
Format 

General drawer. Can 
potentially teach FIU how 
to update Access DB/UI 

General drawer, but 
long-term changes 
are not within scope 

General drawer, but 
long-term changes 
are not within scope 

Usability 
   

Reporting 
Institutions 

Upload flat file with raw 
data 

Upload flat file with 
raw data or banks 
manually fill out 
forms 

Upload flat file with 
raw data or banks 
manually fill out 
forms 

FIU Storage FIU downloads onto 
computer and imports into 
Access database 

Automatically 
downloads into 
database 

Automatically 
downloads into 
database 

FIU 
Investigations 

Search form and reports in 
Access 

Search form Search form 

Support for 
Multiple Users 

from FIU 

Need to share most up to 
date Access database file 
or individually 
download/import new files 

Yes Yes 

Reasonable 
Response Time 

Yes Dependent on 
bandwidth 
(reasonable) 

Yes, for FIU.  
No, for Offsite 
banks. 
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Appendix C. 
CSV File Specifications 
We would like to receive the CTRs and STRs via CSV files.  A CSV file is a text file with the use of the comma 
as the field separator for the data. 
1.     Fields/columns are separated by the comma character. 
2.     Records/rows are terminated by newlines. 
3.     All records should have the same number of fields, in the same order. 
4.     Any field may be quoted (enclosed with double-quote characters) 

“1998”,“Jim”,”Schwartz” 
5.     Fields with embedded commas or double-quote characters must be quoted. 

1998,Jim,Schwartz,”Nice, friendly guy” 
1998,Jim,Schwartz,”Nice, ““friendly”” guy” 

6.     The first record must be a header, which contains column names for each of the fields 

Required fields and format for STRs 
Each row of a csv will correspond to a unique STR. 
We require 26 fields. We used submitted STRs as the template for the fields and extracted a subset of the fields 
containing only the information needed by the FIU. If a field has options, such as “yes” or “no”, the available 
options are listed under the numbered field as bullet points. 
1.   accountNumbers 
2.   nameOfBranchOfficeAgency 
3.   fullNameOfFinancialInstitution 
4.   lastNameOrNameOfEntity 
5.   firstName 
6.   middleName 
7.   address 
8.   addressCity 
9.   addressState 
10. zipCode 
11. addressCountry 
12. phoneNumberResidence 
13. phoneNumberWork 
14. occupationOrTypeOfBusiness 
15. dateOfBirth 

·      MM/DD/YYYY 
16. admissionOrConfession 

·      yes 
·      no 

17. idNumber 
18. idIssuingAuthority 
19. relationshipToFinancialInstitution 

·      Accountant 
·      Agent 
·      Appraiser 
·      Attorney 
·      Borrower 
·      Broker 
·      Customer 
·      Director 



 

Financial Intelligence Unit  Page 23 of 91 
Joshua Antonson, Student Consultant  August 7, 2015 
Laura Lodewyk, Student Consultant 
 

·      Employee 
·      Officer 
·      Shareholder 
·      Other 

20. typeOfInsiderRelationship 
·      None 
·      Suspended 
·      Still employed at financial institution 
·      Terminated 
·      Resigned 

21. dateOfSuspensionTerminationResignation 
·      MM/DD/YYYY 

22. stateDateOfSuspiciousActivity 
·      MM/DD/YYYY 

23. endDateOfSuspiciousActivity 
·      MM/DD/YYYY 

24. amountOfCash 
25. summaryCharacterization 

·      Money Laundering and Proceeds of Crime Act 
·      Bribery/Gratuity 
·      Check Fraud 
·      Check Kiting 
·      Commercial Loan Fraud 
·      Computer Intrusion 
·      Consumer Loan Fraud 
·      Counterfeit Check 
·      Counterfeit Credit/Debit Card 
·      Counterfeit Instrument (other) 
·      Credit Card Fraud 
·      Debit Card Fraud 
·      Defalcation/Embezzlement 
·      False Statement 
·      Misuse of Position or Self Dealing 
·      Mortgage Loan Fraud 
·      Mysterious Disappearance 
·      Wire Transfer Fraud 
·      Terrorist Financing 
·      Identity Theft 
·      Other 

26. narrative 

Required fields and format for CTRs 
The CTRs will be broken up into two CSV files. One file will have information for the Person(s) involved in 
transactions (PIT_info) and another file will have the rest of the information for the CTRs (CTR_info). This 
method was chosen to facilitate easy and reliable importing of the files into the FIU’s database and will be 
sustainable once the consultants leave. 
PIT_info: 
        Each row will correspond to a unique “Person Involved in Transaction” entry for each CTR that has 
been filed. This information comes from the current CTR format that each bank files with FinCen: Part I Person 
Involved in Transaction. For example, if there are three CTRs filed in a given time period: CTR1, CTR2, CTR3. 
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Where CTR1 and CTR2 have 3 persons involved in the transaction and CTR3 has 1 person involved in the 
transaction. Then, PIT_info will have a total of 7 entries, with each row corresponding to one person involved in 
the transaction across all of the CTRs. 
CTR_info: 
        Each row will correspond to a unique CTR. The fields in each entry were derived from Part II and Part 
III of the current CTR format that each bank files with FinCen. 
PIT_info and CTR_info will be linked together through a CTRID. Each “person involved in transaction” entry 
will have the CTRID of the CTR that they are associated with. In order to ensure that CTRID is unique across 
the three financial institutions we require that each bank include a unique identifier as part of the CTRID. 
The format will be: 
        “bank identifier”.”CTR identification number” 
The CTR identification number can be whatever each respective bank uses to uniquely identify their CTRs. 
Bank identifiers: 
        Bank of Hawaii: 1 
        Bank of Guam: 2 
        Bank Pacific: 3 
So, if Bank of Guam has a CTR with an ID/filing number of: 
        CTRB1500104000006 
Then the CTRID would be: 
        2.CTRB1500104000006 
Fields for PIT_info: 
1.    CTRID 
2.     relationshipToTransaction 

·      Person on whose behalf transaction was conducted 
·      Person conducting transaction for another 
·      Person conducting transaction on own behalf 
·      Courier Service (private) 

3.     lastNameOrNameOfEntity 
4.     firstName 
5.     middleName 
6.     gender 
7.     occupationOrTypeOfBusiness 
8.     address 
9.     addressCity 
10.  addressState 
11.  zipCode 
12.  addressCountry 
13.  dateOfBirth 

·      MM/DD/YYYY 
14.  contactPhoneNumber 
15.  emailAddress 
16.  idType 
17.  idNumber 
18.  idCountry 
19.  idIssuingAuthority 
20.  accountNumbers 
21.  cashDirection 

·      Withdrawal 
·      Deposit 

22.  cashAmount 
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Fields for CTR_info: 
1.    CTRID 
2.     dateOfTransaction 

·      MM/DD/YYYY 
3.     cashDirection 

·      Withdrawal 
·      Deposit 

4.     cashAmount 
5.     typeOfFinancialInstitution 
6.     fullNameOfFinancialInstitution 
7.     nameOfBranchOfficeAgency 

Reference Files 
        ctrs.csv 
        strs.csv 
        pit.csv 

Conclusion 
Please let us know if there are concerns or questions related to the proposed CSV formatting for CTRs and 
STRs. If formatting the data in this way is not possible, then please let us know as soon as possible so we have 
time to find a better solution. If certain fields are not present in the data for a respective bank, please leave those 
blank. 
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Appendix D. 
Tables Diagram: 
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Appendix E. 

MainForm: 
• The MainForm is the home page for the application. 

 
 

• The CTRs Query subform displays matching CTRs from the CTRs Query. 
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• The STRs Query subform displays matching STRs from the STRs Query. 

 
• The CBCRs Query subform displays matching CBCRs from CBCRs Query. 

 
 
 
 



 

Financial Intelligence Unit  Page 29 of 91 
Joshua Antonson, Student Consultant  August 7, 2015 
Laura Lodewyk, Student Consultant 
 

• The FIB Query subform displays matching Companies from the FIB Query. 

 
• The Cases Query subform displays matching Cases from Cases Query. 
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• You can search by last name or name of entity, account number, or between a Start date 
and End date. 

• When you click on Search, it runs the CTRs Query, STRs Query, FIB Query, CBCRs 
Query, and Cases Query. The matching results are displayed in the five subforms discussed 
prior. 

 

 
• There are reports that generate aggregated results by Month, Year, and Person. 
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• To view/edit/add individual CTRs, STRs, CBCRs, Cases, or Companies. 

 

CTRs: 
• The CTRs form is where you can view, edit, and add CTRs. 
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• Person(s) associated with CTRs are displayed in Part III. 

 
• You can scroll through CTR entries and the Person(s) in a CTR. 
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• You can search for a CTR by CTRID. 

 
• To add a new CTR. 
• Note: You must enter in a CTRID before filling out any of the other fields. 
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• To add a new Person to a CTR. 

 
• To delete a CTR. 
• Note: You must delete all the Person(s) involved in the transaction before you can delete 

the CTR. 
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• To go back to the MainForm. 

 
 

STRs: 
• The STRs form is where you can view, edit, and add STRs. 
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•  You can scroll through the STR entries. 

 
• You can search for a STR by STRID. 
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• To add a new STR. 

 
 

• To delete a STR. 
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• To go back to the MainForm. 

 

 

FIB: 
• The FIB form is where you can view, edit, and add company information. 
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• You can scroll through the companies. 

 
• You can search for a company by FIBID. 

 
 
 
 
 
 



 

Financial Intelligence Unit  Page 40 of 91 
Joshua Antonson, Student Consultant  August 7, 2015 
Laura Lodewyk, Student Consultant 
 

• To add a new company. 

 
• To delete a Company.
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•  To go back to the MainForm. 

 

CBCRs: 
 

• The CBCRs form is where you can view, edit, and add CBCRs. 
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• You can scroll through the CBCR entries. 

 
 

• You can search for a CBCR by CBCRID. 

 
 
 
 



 

Financial Intelligence Unit  Page 43 of 91 
Joshua Antonson, Student Consultant  August 7, 2015 
Laura Lodewyk, Student Consultant 
 

• To add a new CBCR. 

 
 

• To delete a CBCR. 
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• To go back to the MainForm. 

 
 

Cases: 
• The Cases form is where you can view, edit, and add Cases. 
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• The Select Related CTRs for Case Query subform displays the CTRs that belong to a Case 

 
 

• To add or remove a CTR to/from a Case by CTRID. 
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• The Select Related STRs for Case Query subform displays the STRs that belong to a Case. 

 
 

• To add or remove a STR to/from a Case by STRID. 
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• The Select Related Companies for Case Query subform displays the companies that belong 
to a Case. 

 
 

• To add or remove a company to/from a Case by FIBID. 
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• The Select Related CBCRs for Case Query subform displays the CBCRs that belong to a 
Case. 

 
 

• To add or remove a CBCR to/from a Case by CBCRID. 
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• You can scroll through the Cases. 

 
 

• You can search for a Case by CASEID. 
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• To add a new Case. 

 
 

• To delete a Case. 
Note: You need to remove any associated CTRs, STRs, Companies, or CBCRs before you can 
delete the Case. 
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• To go back to the MainForm. 
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Appendix F. 
Windows Homegroup and Sharing Files: 

 Now that each user has a copy of the front-end database, we need a way for them to have 
access to the back-end database, which resides on one user’s computer. We will use Windows 
Homegroup in order to share access to the back-end database file.  
 
 A Homegroup makes it easy to share files across a home or work network. One user creates a 
Homegroup and then other users join that Homegroup. Each user can then select the files or libraries 
that they want to share with the other users and the access level (read/write) to those files.  

 

 

Joining the Homegroup and Sharing Files: 
1. Click on the Homegroup tab in the Windows Explorer. 
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2. There should be a message that your computer has detected a Homegroup on the network. 
Click Join now. 

 
3. Select what you want to share with the Homegroup. We recommend only sharing Documents. 

Click Next. 
• Only the computer that is sharing the back-end database needs to share Documents. 

The other computers do not have to share anything. 
• This means that any files that are in Documents will be shared to the other computers in 

the Homegroup. 

 
 



 

Financial Intelligence Unit  Page 54 of 91 
Joshua Antonson, Student Consultant  August 7, 2015 
Laura Lodewyk, Student Consultant 
 

4. Enter the Homegroup password. Click Next. 

 
5. There should a message confirming that you have joined the Homegroup. Click Finish. 
6. Under the Homegroup tab in the Windows Explorer, you can now see all of the computers that 

are currently connected to the Homegroup. 

 
 

7. Once you click on one, you can view the files that the computer is sharing with the 
Homegroup. 
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Sharing the back-end database file: 
1. Right-click on Documents folder and click on Share with -> Homegroup (Read/Write) 

• This will ensure that all the files in this folder can be viewed and modified by other 
members of the homegroup 

• If there are certain files that you do not want to share, click on Share with -> Nobody. 

 
 

2. Create a folder called FIU Database in the Documents folder, if it does not exist already 
• This will be the location for files to share with the Homegroup. 

3. Right-click on FIU Database and click on Share with -> Homegroup (Read/Write). 
• This will ensure that all the files in this folder can be viewed and modified by other 

members of the Homegroup. 
4. Move the back-end database file into the FIU Database folder.  

 
 
 
 
 
 

-- Continued on next page -- 
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5. Right-click on the back-end database file and click on Share with -> Homegroup 
(Read/Write). 

 
6. The file can now be viewed and modified by other members of the Homegroup. 
 

Where to find the back-end database files for other users: 
 
1. Under the Homegroup tab in the Windows Explorer, you can see all of the computers that are 

currently connected to the Homegroup. 
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2. Once you click on one, you can view the files that that computer is sharing with the 
Homegroup. 

 
3. Navigate to the back-end database file FIU - Copy_be, which is located in the FIU Database 

folder. 
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4. Now, you can link the front-end copy to this back-end database file. 
• In order for you to access the back-end database file, the computer that it sharing it must be 

on and connected to the Homegroup. 
• In order to modify the contents of the database, the back-end database file must be shared 

with read/write access to the Homegroup. 
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Appendix G. 
Splitting an Access database: 

  
 In order to allow multiple users to use the database concurrently, it is necessary to split the 
access database. When you split a database, you reorganize it into two files: a back-end database that 
contains the data tables and a front-end database that contains queries, reports, and forms. Each user 
has a local copy of the front-end database and then one user has the back-end database. The other users 
can access that copy of the back-end database over the local network.  
 

1. On your computer, make a copy of the database file.  
● This ensures that if something goes wrong during the process, you have a working version 

of the database. 
2. Open the copy of the database file. 
3. Under the Database Tools tab, in the Move Data group, click on Access Database. This opens 

the database splitter wizard. 

 
4. Click Split Database. 
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5. In the Create Back-end Database window, specify a file name, database type, and location for 
the back-end database file. 

● We recommend using the default name and database type that Access recommends. 
● Choose the location for the back-end database file. 

 
6. Once complete, there will be a confirmation message. 

 
7. The database is now split. The front-end database is the file that you initially started with (the 

copy of the original database). The back-end database is the file that you created in step 5.  
8. You can now distribute the front-end database file to each of the users. You can send using an 

attachment in an email, a usb drive, or shared network folders.  
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Appendix H. 
Linking an Access database: 

 
 Now that the database is split each user has a copy of the front-end database file. We need to 
link that front-end database file to the back-end database in order to access/edit the data tables.  
 

1. Open the front-end database file. 
2. Under the Database Tools tab, in the Database Tools group, click Linked Table Manager. 

 

 
 

3. Click Select All in order to relink all of the data tables. In order to choose the location of the 
back-end database, click the checkbox for Always prompt for new location. 

● If you want to relink only a single table, then click only on that table’s selection box. 
 

 
 
 
 

4. Click OK. 
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5. Navigate to the location of the back-end database file and select it. Click Open.  

 
6. The front-end database is now linked to the back-end database.  
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● This allows the user to be able to use any forms, queries, or reports in the front-end database 
that are associated with the back-end database data tables. 
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Appendix I. 
2GB Access Database Size Limit: 

 
 There is a size limit of 2GB for databases in Access. The key step to avoid running into issues 
with the size limit is to split the database into a front-end and back-end. In addition it is a good idea to 
compact and repair the Access database after use. As the database grows in size, Access keeps around 
temporary and deleted data behind the scenes. In order to free up that space, we need to compact and 
repair the database. 
 

Automatically Compacting and Repairing database: 
1. Open the Access database. 
2. On the File tab, click Access Options. 

 
3. In the Access Options dialog box, click Current Database. 
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4. Under Applications Options, ensure that Compact on Close is selected. 

 
5. From now on, each time you close the database, Access will automatically compact and repair 

the database.  
 
 If the database is approaching the 2GB database size limit, the next option is to split each data 
table into its own file and relink the database. This essentially allows each data table to be up to 2GB, 
whereas before the sum of the data tables could be up to 2GB. This should not be an issue unless the 
number of reports filed with the FIU per year grows dramatically.  
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Moving Each Table to Own File and Relinking: 
 

1. Create a new Blank Database in Access. 
2. Under the External Data tab, in the Import group, click Access. 

 
3. Select the file of the previous database to import the table from using Browse... 
4. Select Import tables, queries, forms, reports, macros, and modules into the current 

database. Click OK. 
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5. Select the table to import and click OK. 

 
6. There should be a confirmation message. Click Close. 
7. The database now has the imported table. Repeat steps 1-7 for each table in the database. 
8. Relink each table in the front-end database to the correct database file for each individual table. 
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Appendix J. 
Encrypting/Decrypting an Access Database: 

 
 In order to ensure the security of the Access database, it is necessary to encrypt the database. 
Essentially, this means protecting the database with a password, so if someone does not have the 
password they cannot use the database or see the data contents of the database. 
 

1. Open the database in Exclusive mode. 

 
2. Under Database Tools tab, in the Database Tools group, click Encrypt with Password. 
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3. Enter in the new password.  
● Use a strong password by combining uppercase and lowercase letters, numbers, and symbols.  
● Strong password: a23dj!le$cd3la%4c 
● Weak password: palaufiu2015 
● Passwords should be at least 8 characters in length. Ideally, a password should contain 14 or 

more characters.  
● Write down the password and store it somewhere secure, until it is memorized. Do not store the 

password on the same computer as the database. 
● If you forget/lose the password, the database can no longer be accessed. 

 
4. Click OK. 
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5. The database is now encrypted.  
● From now on, once you open the database you will be required to enter in the password. 

 
6. If you need to decrypt the database, such as to change the password, under the Database Tools 

tab, in the Database Tools group, click Decrypt Database. 

 
7. Enter in the current password and click OK. 
● The database is no longer encrypted and can be opened without the previous password. 
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Encrypting a split Access database: 
 

1. Encrypt the back-end database. 
2. Relink the front-end database to the back-end database 
3. After you relink the tables, encrypt the front-end database 

 
 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 
 

 
 

 



 

Financial Intelligence Unit  Page 72 of 91 
Joshua Antonson, Student Consultant  August 7, 2015 
Laura Lodewyk, Student Consultant 
 

Appendix K. 
Importing CSV Files into Access Database: 

 
 Once the CSV files are downloaded onto the user’s computer, they must be imported into the 
database. Note: They must be imported directly into the back-end database file, not the front-end 
database copy. 
 

1. Under the External Data tab, in the Import group, click Text File. 

 
2. Click Browse... 
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3. Navigate to the location of the csv file and select it. Click Open. 

 
4. Choose Append a copy of the records to the table and then select the table from the drop-

down list. Click OK. 
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5. Choose Delimited - Characters such as comma or tab separate each field. Click Next. 

 
6. Select Comma as the delimiter to separate the fields. Also, select First Row Contains Field 

Names. Finally, select double quotes “ as the Text Qualifier.  
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7. Click Next. 

 
8. Click Finish. 
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9. Click Close. 
● Optionally, you can choose to save the import steps, so that in the future you do not have to 

walk through the first 8 steps every time. Select Save Import steps. 

 
10. Make sure that Save import steps is selected. Click Save Import. 
● You can choose to rename the import and/or write a description.  
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11. From now on to import this csv file, under the External Data tab, in the Import group, click 
Saved Imports. 

 
12. Select the import and click Run. 
● This will only work if the file has the same name and is in the same location as the first 

imported csv file. 
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Appendix L. 
Website Cost Decision Diagram 

 

 Website Builder Domain Email - would like at 
least 2 

Total Cost per 
Year 

Wordpress $99/year Included Free - Zoho 
10 Users with 5GB 
each 

$99/year 

GoDaddy $9.99/month 
(sale: 
$5.99/month) 

Included 5 free included 
sharing 500MB of 
space 

$120/year 

Wix $8/month free 1 year, 
$???? 

$50/user/year - Google $126/year 

Weebly $4/month ~8/year 
must 
connect 

$50/user/year - Google $156/year 

Squarespace $18/month $20/year $50/user/year - Google $336/year 
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Appendix M. 
Website Domain Name, Hosting, and  Email: 

 
Wordpress - Domain registrar and website hosting service 
Domain Name: palaufiu.org 

Associated Cost: Premium Plan (includes domain) $99/year 
Zoho Mail - Email 

Associate Cost: Free, for up to 10 users 
 
The following instructions were followed to link the FIU domain and zoho mail: 
https://en.support.wordpress.com/add-email/add-email-through-zoho-mail  
 
 
 

Common Email Tasks: 

To login to webmail: 
1. Go to https://www.zoho.com/mail/login.html  
2. Log in using your email and password 

 

To add emails*: 
*Note: the free plan has only 10 emails 

1. Go to https://www.zoho.com/mail/login.html  
2. Log in using your email and password (must be logging in as director@fiu.org) 
3. Hover over ‘Control Panel’ in the upper right until a drop down appears 
4. Click on Mail & Docs 
5. Click on User Details in the sidebar on the left 
6. Click on ‘Add User’ in the menu bar along the top 
7. Fill out the necessary information in the form 

 
 
 
 
 
 
 
 
 
 



 

Financial Intelligence Unit  Page 80 of 91 
Joshua Antonson, Student Consultant  August 7, 2015 
Laura Lodewyk, Student Consultant 
 

Common Website Tasks: 

To customize the theme of the website*: 
 *Note: this includes things like the color scheme, the top menu , the footer with pages/contact info 

1. Go to https://wordpress.com/ 
2. Click on the ‘Log In’ button in the upper right 
3. Log in using the FIU username and password. 
4. Click on ‘My Website’ in the upper left 
5. Click on ‘Customize’ in the left hand sidebar under ‘Look and Feel’ 

 
6. A new page will open, it might take a long time to load 
7. Use the sidebar to customize the theme: 

○ Active Theme: you can change the entire theme of the website. Warning: this will 
completely change the way the website looks, and information could potentially be lost. 
Only change the theme if you are willing to spend some time fixing things. The original 
theme is ‘Motif’ 

○ Site Title, Tagline, Logo:  Lets you change the title, tagline, etc. 
○ Colors & Backgrounds: Lets you edit the colors or color palette.  
○ Fonts: Lets you change the header fonts and body fonts 
○ Header Image: Lets you add or change the header image. 
○ CSS: This is a technical thing. Unless you know what this is, don’t mess with it. 
○ Widgets: 

i. First Footer Sidebar: Conatins Contact info 
ii. Third Footer Sidebar: Contains Page List 

iii. First Front Page Sidebar: Contains the ‘Welcome’ text on the front page 
iv. Second Front Page Sidebar: Contains the ‘Regulations’ text on the front page 

○ Static Front page: Makes the front page (Welcome) static and places posts on the 
regulation page 

○ Testimonials: Not really relevant for the FIU website 
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To post regulations: 
1. Go to https://wordpress.com/ 
2. Click on the ‘Log In’ button in the upper right 
3. Log in using the FIU username and password. 
4. Click on ‘My Website’ in the upper left 
5. Under the ‘Publish’ section in the sidebar, click on the ‘Add’ next to ‘Blog Posts’ 

 
6. A new form for a post will appear 
7. Fill out the title and main text of the regulation in the appropriate fields 

--- IMPORTANT: The following steps will make it so that viewers can’t comment on or ‘share’ the 
regulations. While this is not a necessary step to the overall goal (get the regulation on the internet), it 
adds a layer of professionalism. Since this should only take 3 seconds, it is advised you complete the 
following steps. --- 

8. In the left sidebar, click on advanced settings 
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9. Scroll down until you can see the checkboxes pertaining to ‘Likes & Shares’ and ‘Discussion’ 

 
10. Ensure that all of them are unchecked. Your screen should look like the following. 
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11. Press ‘Publish’ 
12. Ensure that some sort of confirmation appears, most likely in the form of a green banner on the 

top 

 
13. Click on ‘View Post’, or navigate to palaufiu.org/regulations to ensure the regulation was 

posted 
-- Note: if this is the first regulation being posted, it would be a good idea to delete the default post 
‘None’ that says there are no regulations at this time. Instructions on deleting posts are below. -- 
 

To Delete a Regulation Post: 
1. Go to https://wordpress.com/ 
2. Click on the ‘Log In’ button in the upper right 
3. Log in using the FIU username and password. 
4. Click on ‘My Website’ in the upper left 
5. Under the ‘Publish’ section of the sidebar, select ‘Blog Posts’ (Note: press on the text, *not* on 

the ‘Add’ button) 
6. Find the regulation you would like to delete 
7. Click on the ‘trash’ button for the correct regulation 

 
 

To edit the main text of a page: 
1. Click on ‘Pages’ under the ‘Publish’ section of the left hand sidebar 

 
2. Click on the name of the page you would like to edit 
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3. The ‘Edit’ form of the page will open (possible in a new tab) 

 
4. Make the changes you would like to the page 
5. Press ‘Update’ 
6. Ensure that some sort of confirmation appears, most likely in the form of a green banner on the 

top 
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Appendix N. 
Email Encryption using Outlook: 

To protect sensitive information, it is important that any email that you want to stay private is 
encrypted. To do this, it is recommended you use Outlook to encrypt and decrypt your messages. The 
following information is to help the FIU set up and encrypt messages. 
 

Setting Up Outlook: 
First, you most connect your Zoho mail account with outlook. This can be done by following the steps 
below or the directions here: https://www.zoho.com/mail/help/outlook-imap-access.html  

1. Login to Zoho mail 
2. Click on ‘Settings’ in the upper left menu 
3. On the left sidebar, click on ‘POP/ IMAP and Email Forwarding’ 
4. Under ‘IMAP’, click on ‘Enable’ 
5. Open Outlook 
6. Click on Tools > Account Settings > Email Accounts 
7. In the resulting pop up box, select ‘New’ 
8. Select ‘Manually configure Server settings or Additional Server Types’ > Click Next  
9. In ‘Choose Email Service’ page, select Internet mail > click ‘Next’. 
10. In Add New Email Account page, type the following details. 
11. User Information 

a. Your Name – Preferred Display Name 
b. E-mail Address – Provide Zoho Email Address – username@palaufiu.org 

12. Server Information 
a. Account Type – Select IMAP to create an IMAP account 
b. Incoming mail Server – imap.zoho.com  
c. Outgoing mail Server – smtp.zoho.com 

13.  Click More Settings to provide the advanced configuration details.  
14. Logon Information 

a. User name – The email address of your zoho account (user@yourdomain.com for Email 
Hosting users / sername@zoho.com for personal users).  

b. Password – Zoho Account Password (You may require Application Specific password, 
if Two Factor Authentication is enabled for your account.) 

c. Select ‘Remember Password’ 
15. Click on ‘More Settings’, 
16. In the popup that appears, click on Outgoing Server 

a. Select ‘My outgoing server (SMTP) requires authentication’ 
b. Select the option ‘Use same settings as my incoming server’ 

17. Select the tab ‘Advanced’ 
a. Incoming Server (IMAP): 993 
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b. Select ‘This server requires an encrypted connection (SSL)’ 
c. Outgoing Server (SMTP): 465 
d. Select ‘SSL’ from the drop down for encrypted connection 

18. If there is a ‘Delivery’ Section 
a. Select ‘Leave a copy of messages on the server ‘ if you need it in ZOHO mail also. 

19. Click ‘Ok’. You will be back to ‘Add New Email Account’ dialog. 
20. Click ‘Test Account Settings’. Outlook will test the settings by sending a Test mail. 

a. It may ask you for your password, if it asks more than 2 times, you may have not 
completed one of the above steps correctly (or you might be typing your password 
wrong) 

21. When the tests are successful (two green check marks appear next to each item) click ‘Close’ 
22. In the ‘Add Email Accounts’ Window, click Next. 
23. Outlook will display a message for successful completion of Wizard. 

 
The way that Outlook and IMAP are set up, there will be two copies of every sent email placed in your 
‘Sent’ Box. To prevent this, 

1. Go to Tools > Options > Preferences 
2. Under Email Options un-check "Save copies of messages in Sent Items folder" 

 

Getting a Digital Id: 
You must have a digital signature. There are various sites, such as Comodo, that will give you are free 
email certificate. https://www.comodo.com/home/email-security/free-email-certificate.php 
Follow the instructions to create and install your own security certificate 
 

Exchanging Digital Signatures: 
When a message is encrypted, you need a way to decrypt it. The most common way of 
encrypting/decrypting messages is through public/private key encryption. A public key can only 
encrypt a message, not decrypt it. The only way to decrypt a message encrypted with that public key is 
to use the corresponding private key. This way, you can share your public key with anyone and 
everyone, and they can encrypt a message to you using your public key. THen you use your private 
key to decrypt it.  
A digital signature includes your private key, and is also an assurance that it is you sending the 
message (not an imposter) and the contents haven’t been messed with. You can think of it like an old 
fashioned wax seal. To send encrypted messages to each other, you must send your digital signatures 
to each other, and save the key in your contacts. 
You set up your digital signature one of two ways: you can send it on individual messages, or you can 
include it on all sent messages. 
(You can also see these instructions here: https://support.office.com/en-za/article/Secure-messages-
with-a-digital-signature-549ca2f1-a68f-4366-85fa-b3f4b5856fc6?ui=en-US&rs=en-ZA&ad=ZA ) 
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Digitally sign one message: 
1. When in the message, click the arrow under the ‘Options’ group 

 
2. Click on the ‘Security Settings’ button 
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3. Click on the checkbox next to ‘Add Digital Signature to this message’ 

 
4. Click ‘OK’ 
5. Compose and send your message as usual 

 

Digitally sign all outgoing messages: 
1. Under the ‘Help’ Menu click ‘Privacy Options’ 
2. In the left side bar of the pop up box, click ‘Email security’ 
3. Under Encrypted e-mail, select the Add digital signature to outgoing messages check box. 
4. If available, you can select one of the following options: 

 
a. If you want recipients who don't have S/MIME security to be able to read the message, 

select the Send clear text signed message when sending signed messages check box. 
This check box is selected by default. 

b. To verify that your digital signature is being validated by recipients and to request 
confirmation that the message was received unaltered, as well as notification telling you 
who opened the message and when it was opened, select the Request S/MIME receipt 
for all S/MIME signed messages check box. When you send a message with an 
S/MIME return receipt request, this verification information is returned as a message 
sent to your Inbox. 

 
5. Click OK. 
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Updating a contact to include their digital signature: 
1. Right click on the email address in the header of the email 
2. Click on ‘Update Contact’ 

 

Encrypting a Message: 
You have two options for encrypting messages, either encrypt them one at a time, or encrypt all 
outgoing messages. You can also read these steps here: https://support.office.com/en-
za/article/Encrypt-e-mail-messages-84d7e382-5f76-4d71-8705-324489b710a2 
 

Encrypting a single message: 
1. When in the message, click the arrow under the ‘Options’ group 
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2. Click on the ‘Security Settings’ button 

 
3. Click on the checkbox next to ‘Encrypt message contents and attachments’ 

 
4. Click ‘OK’ 
5. Compose and send your message as usual 
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Encrypting all outgoing messages: 
 

1. On the Help menu, click privacy options,  
2. In the side bar click E-mail Security. 
3. Under Encrypted e-mail, select the Encrypt contents and attachments for outgoing messages 

check box. 
4. Click OK. 
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